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ABSTRACT

Vehicle Parking Space Locator with Surveillance System is developed to help

drivers to locate available parking space in a parking area using their mobile devices

via Bluetooth application. The system will provide information about the location of

the parking space as well as the image of the parking area. The objective of the

service is to enhance the existing parking system, to provide better service for

drivers in searching of available parking space, and to utilize the Bluetooth

application in mobile devices as the medium of the services. The service also looks

forward in reducing the traffic congestion, high C02 emission, and the drivers'

precious time which are derived from parking surveys activities. The methodology is

based on the Rapid Application Development (RAD) model, which is the

enhancement of waterfall model, since it is the most appropriate model to be used

for fast project development and delivery if high quality system at low cost of

investment. The service is hope would benefits mobile users and drivers in lowering

thier fuel consumption, saving cost of services, and reducing user's time for parking

surveys. The system will be integrating Visual Basic.NET with Matlab 7.0 tools.

When a client/mobile user requests for available parking space information from the

system via Bluetooth application, the system would respond to the request by

providing the image of the current parking lot as well as the exact locations

information. The parking area would be captured using Visual Basic.NET and the

captured images would be processed using Matlab Image Processing Toolbox.
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CHAPTER 1

INTRODUCTION

1.1 Background of Study

Parking activities constitute a wide area that can affect overall mobility of vehicle

drivers as all vehicle trips require a parking space at destination. Parking surveys

activities can be very frustrating, time-consuming and daunting task to drivers.

Related problems derive from the driver's need of convenient parking space,

especially in areas of scarce parking supply, where drivers' searchfor parking space

may account up to 30% of urban traffic flows and correspondingly high proportion

of CO2 emissions.

The Vehicle Parking Space Locator System focused on developing a service

to locate available parking spacein a particular parking area by usingmobile devices

such as handphone, via Bluetooth wireless technology. The service can be accessed

by drivers as long as the Bluetooth connection in theirhandphone is enabled. When

a request is sent to the system via Bluetooth, the system would respond to the

request by sending the information about the location of available parking space

with the images of parking lot to mobile user. The image of parking lot will be

captured periodically and will be processed using Matlab software tools. The system

should also be able to monitor the activities going on in the parking area and save

the video of the monitoring service.

1.2 Problem Statement

1.2.1 The inefficiency of image processing using RGB in VB.NET



The existing system done by previous FYP uses Visual Basic.NET functions to get

the RGB value from the captured image and compare the image manually by using

pixel value of the image, which is quite tedious.

1.2.2 The high cost of applying WAP service

The former Final Year Project is developed using WAP. Problem with the system

using WAP service is that it needs collaboration with service providers (e.g.

MAXIS, CELCOM) and subsequently requires mobile user/drivers of the parking

space locator system, to pay for the service.

1.2.3 Time-consuming during search of parking space in parking area.

Drivers may to have a complete tour of parking area in just to find a parking space,

which can take for hours especially during weekends and holidays depending on the

area. Studies have found that average time to find a parking space range between

five to fifteen minutes depend on the environment (peak hours, prime hours or off

hours).[10] Drivers and passengers would prefer to spend more time at destination

rather than searching for parking space.

Related problems derived from the searching of parking space activities

especially in areas of scarce supply may results up to 30% of urban traffic

congestions and correspondingly high proportion ofCO2 emission.

1.2.4 The cost for having a parking space locator services available is

high

Currents available parking offers are also source of problems since parking facilities

and parking space locator services are costly and some of it are limited to certain

registered members. Looking at the high living cost and environmental cost, the

services can not benefits drivers much.



1.3 Objectives of the Project

1.3.1 To enhance the available system by using Matlab software.

Every image captured will be processed and compared automatically using Matlab

Image Processing Toolbox and functions rather than process them manually using

RGB functions in VB.NET. The results will be transferred to the main system,

which will be built using Visual Basic.NET. The integration of Visual Basic.NET

and Matlab is important to have better image processing method and better results.

1.3.2 To use Bluetooth technology as a transmission medium instead of

WAP

Since WAP need collaboration with service providers which results to high service

cost for clients, Bluetooth wireless technology provides better alternative solution

for mobile user/drivers. By utilizing Bluetooth, V-PSLS can provide low cost

service with equal or better output. . Bluetooth technology is applied in the system

because of its availability in most of the mobile devices nowadays and its potential

in moving and synchronizing information in a localized setting. Bluetooth

technology is a radio-based and very inexpensive. It devices can communicate at

ranges of up to 100 meters and do not need to be in direct sight of each other, that is

suitable for the system to be accessed.

1.3.3 To reduce time and hassle in searching for parking space.

The purpose of the system is to reduce time needed in searching of parking space in

parking area especially in urban area where traffic congestion is high and

subsequentlyreducing the air pollution and drivers stress problems.

1.3.4 To propose a better parking space locator solution for mobile users



The system is proposed to introduce diversified parking space locator services for

mobile users to make drivers' search for parkingspace more accessible, comfortable

and time-saving. The system is hope be able to provide user with affordable service

and better image presentation in the mobile devices.

1.4 Scope of Study

The scope of study of this project starts with integrating the Matlab and Visual

Basic.NET. How the captured image will be processed and be programmed using

Matlab tools and functions is studied. Then study is extended to how Bluetooth

connection between mobile devices and PC is setup. The understanding of

Bluetooth wireless technology application and devices needed for this system willbe

learned as wellas it significance to this system. The study of Bluetooth personal area

network range, device installations, and how to mobile devices can retrieve

information from the PC.

The system can be use in anyparking area such as shopping mall, university

area, company, housing area and sports center. This project will apply the system

onto real hanphones for testing. Mobile users within the system's Bluetooth area

should be able to detect the service and request for information, and then view the

image of parking area with location of available parking space. The expected user

for the system testing and system validation will be focus more on Universiti

Teknologi PETRONAS (UTP) students due to the scarcesupplyof parking space.



CHAPTER 2

LITERATURE REVIEW

2.1 Parking Space Optimization Service

According to Hodel-Widmer and Cong (2004)

E-Parking provides a database-centered Web application solution based on our

proposed conceptual model CIA (Channel, Integration, Application) for Web

applications. The WAP, WEB and Bluetooth communication channels enable

drivers to obtain early information on available parking space, make a

reservation, access the reserved place and pay for the service booked. In

reaching this goal, the innovative solutions seekto benefitall social segments, to

optimize existing parking resources, and to contribute to achieving a more

sustainable urban transport, reducingcongestion and pollution, (p. 1).

PSOS is accessed both by drivers through Web, SMS or WAP technology and

by parking space providers through Web Services to the central database.

Bluetooth technology then enables the driver to be recognized at the entry and

exitpoints of the parking lot andtriggers the secure m-payment procedure which

debits his credit card or phone bill. (p. 3)

The parking space provider offers parking space available for reservation. This

information is registered in the PSOS database. Users are able to access the

PSOS via Internet or WAP for obtaining parking information or for making a

reservation request. The reservation request is registered in the PSOS database.

ThePSOS sends the booking information and access codeto the end user subject

to the acceptance of the reservation request by the Parking Space Provider. The

car enters and exits the parking facilities using Bluetooth to open the barrier.



Once the car exits the car park electronic payments is made and the whole

operation is registered in the PSOS. (p. 4)

Basically this system can be accessed both by drivers through WEB and WAP

technology and by parking space providers through a specific interface to the central

database. Bluetooth technology then enables the driver to be recognized at the entry

and exit points of the parking lot. The system aims at supporting different business

models in which payment flows can be either handled through the PSOS platform or

at parking provider level. The combination of these technologies makes the system

quite efficient but yet expensive.

2.2 Parking System Technologies

Smith and Roth (2003) talks about how advanced Car Park techniques are being

implemented using the SMS services available on cellular phones. It describes how

useful these advanced car parking systems are in providing drivers with information

about the structure of the car park system and the spaces available for them to park

their cars.

The availability of the vacant parking spaces is calculated by means of

sensors installed in the parking areas, which count the number of cars that enter and

exit from the parking space. Also, the number of parking tickets issued at the ticket

counter can be used to calculate the vacant spaces. All this information from the

sensors and the ticket counters is used to update a central database which stores all

the information about the areas of the parking space which is vacant or occupied.

Smith and Roth (2003) also compares the parking techniques used at various airports

in the United States. Among these, the notable ones are Houston International

airport and the Baltimore airport at Massachusetts. The parking spaces at Houston

international airport have wires embedded at the entry, exits and the various levels

of the parking lots. These wires act as sensors and record the entry and exit of the

card to update the central database. At the Baltimore airport, there are ultrasonic

sensors at the top of each parkingspace which sensethe availability or unavailability

of each space. These sensors update the central database. Information from this
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central database is used to display information at the "way-find" signs at the end of

each row of the parking area and advise the drivers whether parking space is

available or unavailable in that particular row.

These advanced car park systems also provide advanced, electronic payment

options for the customers. The idea behind these electronic payment options is to

prevent the customers from having to wait in long queues to buy a ticket. In this

article, cite examples of mobile parking or "m-parking" facilities that are beingused

in Vienna (Austria) and Melbourne (Australia). Under the m-parking technology,

customers initially register their mobile number, the license plate number of the car

and their credit card number with the car park authorities, to create virtual parking

ticket account. This completes the initial, one-time registration process. Whenever

the customer needs to park, they would send an SMS text message to the number

provided by the car park authorities. The SMS message would consist of the license

plate number of the car, the location code of the parking area where they want to

park and the time duration (in minutes) for which the customer wants to park. In

return, the customer would then receive a text message from the car park message

centre, with the confirmation and the expiry time of their electronic parking ticket.

The customer would be sent a reminder SMS, 10 minutes before the parking time

expires. The bill for the parking ticket would come up on the customer's mobile bill.

2.3 Location Dependent Parking Service through Bluetooth

The system proposed by Suryanarayana, Mariappan and Narayanasamy(2005)

allows the mobile client to search for parking space, reserves the space and enters

the parking space through Bluetooth enabled devices. Location Dependent Parking

Services has three main features; Search Vehicle Park Information, Parking Slot

Information Retrieval and Parking Slot Reservation. This system is implemented

using Microsoft Visual Studio.NET with TomCat web server. User has to logon to

the Location Dependent Service (LDS) system through their mobile device and

search for nearby parking space by choosing the location where the user wants to

park OR searching the nearby parking area with respect to their current location.



Then, user has to choose one from the given list. The Location Dependent Service

Management (LDSM) will provide the roadmap to reach the parking area and the

number of available slots, space, cost, and other information related to the service

provider according to the users current location. On selecting the parking space, the

system would store the vehicle information in service provider's database. On

selection of the parking space, the system would get the vehicle details and inform

the Location Dependent Service Management (LDSM). The Location Dependent

Service Management (LDSM) will take all the vehicular information and store it in

the service provider's database. On confirming the reservation of the slot, an

"Authentication code" would be generate and send to the mobile user as well as to

the Bluetooth enabled car park system. On reaching the parking slot Bluetooth-

enabled device in the parking slot can interact with the Bluetooth-enabled mobile

and exchange the authentication details. If the user could not reach and park the

vehicle with in expiry time limit the parking system will issue a warning message

through user mobile device and the reservation would get cancelled automatically

after the timeout period.

2.4. Bluetooth Wireless Technology

The articles from BlueTomowrow.com and Bluetooth.com described from the basic

information of Bluetooth to the details architecture of Bluetooth. This site also

provides the articles and review about the Bluetooth devices as well as Bluetooth

softwares and modulessuch as BlueTools.NET SDKwhich can integrate with .NET

framework applications. These sites provide comprehensive guide on Bluetooth and

its advantages.

Based on Tech Publication PTE LTD (2001), Bluetooth technology is a

short-range wireless technology that allows communication between devices.

Bluetooth wireless technology specification is globally available free-of-charge to

our member companies. Bluetooth technology operates in the 2.4 GHz, one of the

unlicensed industrial, scientific, medical (ISM) radio bands. As such, there is no cost



for the use of Bluetooth technology. While youmust subscribe to a cellularprovider

to use GSM or CDMA, with Bluetooth technology there is no cost associated with

the use beyond the cost of the mobile device. A fundamental Bluetooth wireless

technology strength is the ability to simultaneously handle both data and voice

transmissions that enables users to enjoy variety of innovative solutions such as a

hands-free headset for voice calls, printing and fax capabilities, and synchronizing

PDA, laptop, and mobile phone applications to name a few.

Bluetooth have secure connection. With adaptive frequency hopping (AFH),

the signal "hops" and thus limits interference from other signals. Further, Bluetooth

technology has built-in security such as 128bit encryption and PIN code

authentication. When Bluetoothproducts identifythemselves, they use the PIN code

the first time they connect. Once connected, always securelyconnected.

The Bluetooth core system consists of an RF transceiver, baseband, and

protocol stack. The system offers services that enable the connection of devices and

the exchange of a variety of data classes between these devices. Bluetooth enabled

electronic devices connect and communicate wirelessly through short-range, ad hoc

networks known as piconets. Each device can simultaneously communicate with up

to seven other devices within a single piconet. Each device can also belong to

several piconets simultaneously. Piconets are established dynamically and

automatically as Bluetoothenableddevices enter and leave radio proximity.

The operating range depends on the device class. Class 3 radios have a range

of up to 1 meter or 3 feet, while Class 2 radios, which most commonly found in

mobile devices, have a range of 10 meters or 30 feet, and Class 1 radios, which is

usedprimarily in industrial use cases, havea range of 100 meters or 300feet.

The most commonly used radio is Class 2 and uses 2.5 mW of power. Class

3 uses 1 mW (0 dBm) of power and Class 1 use up to lOOmW of power. Bluetooth

technology is designed to have very low power consumption. This is reinforced in

the specification by allowing radios to be powered down when inactive. The data



rate for Bluetoothis 1 Mbps for Version 1.2 and up to 3 Mbps supportedfor Version

2.0 + EDR

From above information, Bluetooth is the best solution to be use in this

project as it provides easy-to-setup installation, inexpensive and wide range of

operation. Bluetooth technology has a big potential that it can be use in many areas

of human daily activities as many devices has been developed utilizing Bluetooth

technology.

2.5 Developing Bluetooth Application in GIS

There are articles that provide step by step instruction on how to configure user

computer or PDA for Bluetooth communication and demonstrate how to build a

Bluetooth server application and a Bluetooth client application. For example,

according to the article display in National Instrument website, describe about

LabVIEW application.

LabVIEW 7.1 and later include Bluetooth Vis with which LabVIEW

developers can build custom Bluetooth applications. This application note

demonstrates how to build a LabVIEW application to communicate with

Bluetooth-enabled devices. Refer to the Bluetooth Web sites at

www.microsoft.com and www.bluetooth.com (linked below) for more

information about Bluetooth technology

Creating Bluetooth server and client applications in LabVIEW is similar to

creatingserver and client applications for TCP communication. A Bluetooth

server uses the Service Discovery Protocol (SDP) to broadcast the

availability of the services contained and listens for inbound connections. A

client creates an outbound RFCOMM connection to a server. Once the client

and serverconnect to each other, they exchangedata until the client or server

terminates the connection or until the connection is lost. There is no inherent

security built into the Bluetooth protocol, although many devices include

10



settings that require clients to log in before accessing Bluetooth services (p

1).

2.6 Mobile Internet Enabled Sensors Using Mobile Phones

According to Rebolj and Menzal (2003)

The Internet Protocol (IP) provides standardized means of communication.

Utilizing IP for communication has numerous advantages over developing

proprietary protocols, e.g., compatibility, flexibility and ease of maintenance.

However, traditional TCP/IP implementation requires extensive CPU and

memory resources. For mobile applications we strive for small, light devices

with low power consumption, thus long battery life. To meet this

requirement a special TCP/IP stack IwIP (Dunkels 2002) has been used. It is

a TCP/IP stack implementation optimized to reduce memory and CPU

resources. For the connection to the mobile phone, Bluetooth was used. The

Bluetooth standard defines a set of profiles for communication. To support

commercially available Bluetooth devices such as the Compaq iPAQ or cell

phones like Ericsson P800, a minimized Bluetooth stack, lwBT (Ohult,

2003) has been implemented on our EIS device. The stack extends IwIP with

Bluetooth LAN access capabilities such as the LAN Access Point (LAP) and

Dial- up Networking (DUN) profiles. The EIS device acts as a Bluetooth

device providing a TCP/IP interface for data transport, configuration and

maintenance. This concept allows user interaction through standardized

WWW browser technology from any device supporting the Bluetooth LAN

Access Profile. The EIS provides platform independent client software for

data presentation. The client software (e.g. applets) is distributed from the

EIS device by HTTP. The applet is run under the client browser, enforcing

security. Sensor data can then be transferred over IP and displayed on the

client device for on-line monitoring, (p.4)

2.7 Integrating Matlab and Visual Basic .NET

11



The integration between MATLAB and Visual Basic .NET is possible with the

Image Acquisition Toolbox and Image Processing Toolbox in MATLAB software.

There are certain projects and research based on the integration between MATLAB

and Visual Basic .NET application have been done. For example, in developing the

Wireless Channel Simulator, the wireless channel was built up with a mathematical

model, and simulated by a MATLAB-based program. The simulation program and

interface program of this wireless channel simulator are programmed in MATLAB

and Visual Basic (VB) respectively [12]. The interface of the program was created

with Visual Basic and calls the "COM" object of the dynamic link library (DLL) file

provided by the MATLAB program.

2.7.1 MATLAB Builder for .NET and MATLAB COM Integration

Matlab Builder for .NET [16] is an extension to the Matlab Compiler so that

programmers can access them from any CLS-compliant language such as C#,

VB.NET, and C++. It converts Matlab functions to .NET methods that encapsulate

the Matlab code. This tool allows user to generate a COM component that

incorporates an event source, COM stands for Component Object Model, which is a

software architecture developed by Microsoft to build component-based

applications. These event components are accessible through Visual Basic, C++ or

any language that supports COM objects.

MATLAB functions can be created in the m-files and these m-files can be

converted to an executable code from Visual Basic by using Matlab COM

integration. - "The Component Object Model (COM) provides a framework for

integrating reusable, binary software components into an application. Because

components are implemented with compiled code, the source code can be written in

any of the many programming languages that support COM. Upgrades to

applications are simplified, as components can simply be swapped without the need

to recompile the entire application. In addition, a component's location is transparent

to the application, so components can be relocated to a separate process or even a

remote system without having to modify the application." [13].

12



Matlab Support Documentation [14] provides the example for running the

M-File from Visual Basic.NET after creating the COM objects and how to view

methods from the Visual Basic.NET client.

2.7.2 The difficulties of the integration

However, most of the examples and previous people works regarding the integration

between MATLAB and Visual Basic are commonly done by using Visual Basic 6,

C# or C++. The integration with Visual Basic.NET is still in a new field that not

much programs had been created using Visual Basic.NET since MATLAB Builder

for .NET is still new. Thus, the idea of developing this project using Visual

Basic.NET 2003 and using MATLAB Builder for .NET is quite a challenge

especially for beginner programmers.

13



CHAPTER 3

METHODOLOGY

3.1 Methodology Identification

The suitable system development methodology for the system is Rapid Application

Development (RAD) methodology. This methodology is compressing the analysis,

design, build, andtest phases into a series of short, iterative development cycles that

has a number of distinct advantages over the traditional sequential development

model (Waterfall methodology) [11]. The objective of choosing this model is

objective is to build fast system development and delivery of a high quality system

at a relatively low investment cost. It can reduce project risk by breaking a project

into smaller segments and providing more ease-of-change during the development

process. While this system emphasis is on fulfilling the business need, while

technological or engineering excellence is of lesser importance, RAD is most

suitable choice. The project control involves prioritizing development and defining

delivery deadlines or "timeboxes" If the project starts to slip, emphasis is on

reducing requirements to fit the timebox, not in increasing the deadline. Standard

systems analysis and design techniques can also be fitted into this framework. The

RAD methodology is mostappropriate to be adopted in a small to medium scale and

of short duration, where the project scope is focused, such that the business

objectives are well definedand narrow like in V-PSLS.

14
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Figure3.1 Rapid Application Development Diagram

3.2 Planning Phase

The planning phase involved assigning topic for the project by supervisor and

preparing for project proposal. The problems and issues regarding the project are

observed and identified. The methods done for data gathering and problems

identification are by interview, internet searching, journals, articles and reference

books. The list of references and literature review related to the project topic are

looked for after the proposed topic has been approved. The literature review and

research found is studied and the selected research papers are as appeared in Chapter

2. The methodology used for the project development is Rapid Application

Development (RAD). Gantt chart is developed as the results of project schedule and

the system requirement is being identified during project planning. (Refer to

Appendix 1-1).

The system requirement involves theexpected tools needed forproject, theexpected

software required, expected cost and expenses for the project, and the expected

hardware specification. The initial results and findings of project planning are

reported in thePreliminary Report andProgress Report as well as Weekly Report.
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3.3 Analyzing Phase

The additional and available information collected during planning phase is used to

design the system flow, system framework, system requirement, and software and

hardware specification. The cost estimation ofthe project development also has been

calculated. The results of the analysis will be discussed as follow:

3.3.1 Related System Requirements

User Requirementdefinition

1. The V-PSLS shall be available most ofthe time especially during peak
hours and respond within 5 minits on user request.
2. User shall view the current image ofparking space of the parking area
with the location information.

3. The systemshall providethe expectedinformation within the parking
area maximum of 100m range (current maximum range)
4. The cost of installing the application for the administrator shall be as
low as possible and affordable for drivers (with Bluetooth enabled
devices) upon request.

System Requirements specification

1. On user request for the location and image for empty parking space
from the V-PSLS, the requestor shall enable their Bluetooth connection
using Bluetooth devices and the system shall enable the Bluetooth
connection at all time.

2. The images shall be captured in half-real time method (e.g. every 5
seconds) and stored in the system database.
3. The images in the database shall be kept in the system for at least 3
years to ensure system availability and security. Backup ofall the old
files shall be stored in different place.
3. The system shall maintain a log ofall requests that have been made to
the system
4. The user shall be within the Bluetooth wireless maximum range in
order to request the information from the system.
5. The position ofthe webcam/CCTV shall be fixed in particular location
such that the particular parking can be viewed.
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Product Requirement

1. The user interface for V-PSLS shall be implemented using simple
navigation in Visual Basic.NET software and integrate the image
processing with MATLAB Image Processing Toolbox.
2. The interface should be reliable and user-friendly to users (system
administrator).
3. The overall system performance should maintain or improve the
available FYP project.

External Requirements

1. The project shall follow the standards and laws requirements and shall
not violate any legislative requirement or university laws.
2. The project shall bind to all the safety requirements and ethical
requirements of the university.
3. The system shall not disclose any personal information about the
system users apart from their name and id number to others.
4. User shall read and agree to system requirements or product conditions
before using the system for safety.

3.3.2 System Framework

The V-PSLS is aimed at providing service to mobile users. As shown in Figure 4-1,

mobile users should be able to access the system within the service area as long as

their Bluetooth connection is on. Their mobile device will detect the Bluetooth

devices of the system and view the system interface. When user requests for

available parking from the system, the signal is sent through Bluetooth to the

system. Then the system will store the user's information such as IP address into the

system. In return, the system will send the information about the location of

available parking space, at which level with corresponding parking area image.

The system should be able to capture the images of the parking area periodically for

instance every 5 seconds to ensure that the availability of parking space and

accuracy of images give to user. This is also for security purpose, where the system
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can monitor and identify the parking area activities. An alarm will be generated if

the systemdetects any unusual actions or eventshappen in the parkingarea.

As an initial draft of the system, a webcam will be used as a substitute for CCTV. A

parking area prototype of A3 paper size will be builddue to the limited fieldof view

range of webcam. This project will be using Bluetooth operating area of 10 meters.

This can be extended up to 100 meters for wider covered-area and better service.

The image of the prototype parking area will be captured periodically using

webcam. These images will be processed and compared using Matlab 7.0 Image

Processing Toolbox, before it will be stored into the database application. Then, the

images can be viewed from the system interface which will be developed using

Visual Basic.NET.

Bluetooth Environment

Vehicle Parking Space Locator System

VB.Net

System
Interface

Figure 3.2 System Framework

Matlab 7.0

<—• Img Acquisition Toolbox

Img Processing Toolbox

Database
(Microsoft Access)

3.3.3 Use-Case Diagram

18



Use-case Diagram is used to describe the functionality of the system, who initiates

the events, and flow ofthe events, and how the system responds to those events.

VEHICLE PARKING SPACE LOCATOR

SYSTEM WITH SURVEILLANCE

Figure 3.3 Use-Case diagram of V-PSLS

19



3.3.4 Minimum Software Requirements

(i) Visual Studio .NET 2003/2005 with Visual Basic.NET

Visual Basic.NET is the main application used to capture the image and to

design system interface. Additional installer also needed for the system to

work better such as Microsoft .NET framework SDK vl.2. Additional

ActiveX installed for this project is IcImagingControl application for

video/image processing.

(ii) MATLAB 7.0 (or above)

Matlab is used to process the images of parking area that are captured using

webcam. Image Processing Toolbox is required during installation for this

purpose. Other important features are Matlab Builder for .NET and Matlab

Builder for COM Integration. These toolboxes are needed and very helpful

when comes to the integration with VB.NET part.

(iii) Microsoft Access / Microsoft Excel

Microsoft Access or Microsfot Excel can be used as a database application to

store processed image information, for system that has limited disk space.

Other database application also can be use to store the images but it requires

larger amount ofdisk space and memory space.

(iv) Bluetooth Software - IVT BlueSoleil

IVT BlueSoleil, which is Bluetooth software, comes with the Bluetooth USB

Adapter. The installer is require before the Bluetooth Adapter is plug in to

the PC for the first time. Other Bluetooth software may also be used as long

as they are compatible with the PC operating system and Graphic Card

requirements.

3.3.5 Minimum Hardware Requirement (For project development)
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Hardware Specification

©Desktop PC

Operating system: Windows XP

Processor: Intel Pentium 4 2.8 GHz

Memory: 256MB DDR RAM (512MB or above is

recommended)

Hard disk: 80GB or above

Graphic Card: Updated graphic card drivers

(ii) Webcam

Video Resolution: 640x480 (300K pixels)

Speed: 30 frames/seconds

Digital Zoom: 3x

PC Interface: USB Port

(iii) Bluetooth USB

Adapter (Bluetooth

Dongle)

Bluetooth vl.2/2.0 compliant

USB UHCI/OHCI specification 2.0 compliant

Up to 100 meter range

Workswell with Bluetoothenabled mobilephones

(iv) Bluetooth-enabled

mobile phone

Any mobile phone with Bluetooth. The mobile phone

model used for this system is NOKIA.

Table 3.1 Hardware Specification

3.3.6 Project Development Cost Estimation

Project Development Cost Estimation

No Items Quantity

Expected

Cost

(RM)

Actual

Cost

(RM)

Hardware Requirement

1 Parking Prototype (car toys) 10 30.00 28.90

2 Webcam 1 60.00 58.00

3 Bluetooth Adapter 1 30.00 35.00

Additional Requirement

4 Upgrade DDR RAM (from 256MB to 512MB) 1 200.00 230.00

5 Replace Graphic Card (broken) 1 150.00 280.00
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Miscellaneous

6 Papers (reports and research paper) 2 rim 15.00 20.00

7 Printer Ink (EPSON C59) 3 66.00 69.00

8 Bluetooth Mobile Phone 1 1000.00 680.00

TOTAL 1551.00 1400.90

Table 3.2 Project Development Cost Estimation

3.4 Designing Phase

In designing phase, storyboard of the system is drafted based on the information

gathered during analysis phases. The system interface and actual algorithms to be

used for the system are identified and applied during this phase. The sub-systems

and functional part of the system is developed. The development method for the

system is bottom-up, from functional parts and sub-function of the system to

development of system interfaces. The designing part is started by developing the

system interface for the system using Visual Basic.NET. Then, continue with image

processing using MATLAB Image Processing Toolbox. Next step, which is one of

the most important parts, is calling the MATLAB code functions from Visual

Basic.NET. After the integration part is completed, the linkage between MATLAB

information and database is created to store the information about location of empty

parking spaces. It is then follows with configuring the connection between Bluetooth

mobile devices and the system.

3.5 System Testing and Validation

Testing phase involve unit testing, component testing, functionality testing, and

reliability testing. However, unit testing and component testing are done frequently

during the designing the system. The tests that shall be done are:

(i) Functionality ofeach controls, link, forms, and buttons on the interface

(ii) The correct linkage between the system and the database

(iii) The outputs, results, and information are produced as expected.
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(iv) The connectivity between Bluetooth mobile phone and system are working

appropriately

(v) The availability of the database

(vi) Whetherany enhancement needed for the systemto performbetter results.

The loops in the methodology helps recognizes issues or updates in during the

design, and testing phase, whichrequires changes to the specifications phase. When

changes are made at any phase, the relevant documentation should also be updated

to reflect that changes.

3.6 Implementation and Deployment Phase

The implementation phase will be done interchangeably with the testing phase to

ensure the result and performance of the system works as expected as well as to

reduce errors. The prototype of the system is presented and ready for external

testing. Feedback and further suggestion for the system improvement is however

required for future enhancement.
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CHAPTER 4

RESULTS AND DISCUSSION

4.1 Results and Findings

Results obtained from researchand findings during planningand analysis phases are

literature review, the advantage of using Bluetooth technology, and quick survey

results. The results of the system development and system testing, present the

system interface, as well as the algorithms and codes that connect between system

methods.

4.1.1 Advantage of Using Bluetooth

Bluetooth is now incorporated into most of the mobile phones and almost everyone

owns a Bluetooth device, so that it would not be long before every driver has a

Bluetooth enabled mobile phone.

Hallberg, Nilsson and Synnes (2003) points out that, "Bluetooth is designed

to have low power consumption and has several power saving functions built into

the protocol". They say that low power consumption is preferred when developing

systems for mobile devices. Bluetooth also provides fast data transfer rate, which is

better that WAP.

Currently, Bluetooth technology provides personal area range up to 100

meters in client-to-client open air and 30 meters in a building. Unlike Infrared that

needs to have a line of sight in order to be connected, Bluetooth radio waves do not

require two connected devices to be in direct sight of each other. This feature allow

mobile user to move around within the Bluetooth range (100 meters).
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This system does not require licensing or registration from any

communication service providers (e.g. MAXIS or CELCOM) compare to WAP-

based system that need collaboration with communication service providers. Thus

the cost of having the service is very inexpensive; hence give benefits to mobile

users/drivers.

As for securitymeasure, Bluetoothmake use of the encryption algorithmthat

was designed as a candidate for US Advanced Encyption Standard (AES). Bluetooth

makes it hard to eavesdrop on a communication betweenBluetooth units compare to

WiFi that suffers from eavesdropping and false authentication [17]. Bluetooth

pairing is said to be safer for transmitting data between mobile users in wireless

environment.

4.1.2 Quick Survey and Questionnaire Results

Based on quick survey and interview done within university and shoppers in

shopping complex in Penang, 60% of students and user of shopping complex agree

to have a parking locator service that is cost-saving, and provide fast service

delivery with clear information about empty parking space.

Quick Survey - The need of parking
space locator service

31%

62%

Figure 4.1 Quick Survey Pie Chart
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4.1.3 System Development

Main Interface. System development involves creating interface and functionality

between each window forms, as well as the form controls such as buttons, menus,

image capturing toolbox and labels. The main interface of the system is shown as

below (Figure 4.2). Initial state ofthe webcam is in Stop Mode. The Live video state

starts once user click the View -> Play link in the Menu bar, or click on the Play

Button (D) inthe Icon Bar.

Menu Bar

Tool Bar

Live Video Place

Current Image -
Ghanges everyS
seconds

Status bar

Mb OWraSefflw View Attocsfcn Hob

BVifcoComoa HQB241320X24(8 NomaspcajOmd

Default image
picturebox-empty
parking area

Information about

available parking
lotaccording to
current Image

Figure 4.2 Main Interface of Vehicle Parking Space Locator System (Initial

State)

Device Setting. User can change the device setting for the webcam by clicking on

the Device Setting -> Device... or Image... in the Menu bar, and on the (0) orB
in the Icon bar. The device setting property depends on the webcam used by user.

The Device Setting (Figure 4.3) and Device Property (Figure 4.4) window is shown

as below:
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Device Settings \

r Video Capture Device-

\ Device Name

j Serial Number

i

Device Settings

Video Norm

Video Format

Frame Rate (FPS)

Input Channel

Update j

---;

\

E3B

)n/a

Properties...

i

. __

h* J

(RGB24 (320x240) d

j30.00003 • 1

r

r

OK | Cancel j

Figure 4.3 Device Setting

Device Properties 305 Video Camera

Color Exposure Image

Hue

Saturation

WNte Balance

Update Default

->

OK

50 -7J
50 -H

•_jp

Cancel

Auto

Figure 4.4 Device Properties

Saving Image. User can saves the single image by clicking on the File -> Save

Image and saves sequence of images every 5 seconds by clicking on Auto Capture -

> Starts in the Menu bar. The Save Image menu item is used to save single image,

which is the default image. Once the image is saved as filename specified by user,
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the image is loaded onto the Default Image picture box. For sequence of images,

once the Auto Capture -> Starts menu item is clicked, user need to specify a folder

where all images that will be captured every 5 seconds, will be stored. Every

captured image is renamed accordingly and loaded onto the Current Image picture

box. The status of each image being captured is showed in the Status bar and the

location information about each lot is displayed on the Current Location text box.

The interface is shown as below (Figure 4.5):

Miiin Vchtcie Parkins? 5{vice i ooilo* System

File DeviceSetting

LiveVideo

CwrentlmafiB

View Auto Capture Help

El tr.

305VideoCsmeia RG624 (320x2401 AgtoCsptute Stops

Figure 4.5 Capturing images

Default Image

Current Locatan

Filename CSDoameiits-siKlSellingsVJSEFil
\0esktopSPro(ect\image\image2 bmp

A1 occupied
A2 occupied
A3 occupied
A4 occupied
A5:occt£»ed
AS: occupied
Bf ivacarK
82: occupied
B3: occupied
64: occupied
B5: occupied
86; ceeigjied
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Saving AVI File. Saving the AVI files can be done by clicking on the File -> Save

Video in the Menu bar or click on the icon (D) in the Icon bar. User can set the

codec properties and save the codec file. Then, the filename and directory of the file

to be saved is browsed. The video capturing starts once the user clicks on the Start

button, and it stops capturing when user clicks on the Stop button. User can choose

to pause the video by Check the Pause.

'Save AVI File fX)

r-Lodecuata -~ '~ ~~"~ ~

Properties jj Codec: jDV Video Encoder jrj

| j:00!c . n , |C:\DocumentsaiTdSettings\USER1\MyDocumen
j j i

\ Save Codec Data j Load Codec Data j

Save As i

i

r Avi CaptureControl -" " ; - -:::::::::::;
! File name: jCADocuments and Setting$\USER1\My Documen

Start : op f~ Pause

SaveAs I |

!

• '-

Close j

Figure 4.6 Saving AVI File Dialog

4.1.4 Algorithm and Codes

(i) Starting and stopping image previewing:

Private Sub StartLiveVideo()
If IcImagingControll. DeviceValid Then

IcImagingControll .LiveStart£)

mnuPlay.Enabled = False

mnuStop.Enabled = True

ToolbarPlayButton .Enabled = False

ToolBarStopButton .Enabled = True

End If

End Sub
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Private Sub StopLiveVideoO
If IcImagingControll.

IcImagingControll
mnuPlay.Enabled =

mnuStop.Enabled =

DeviceValid

.LiveStopO
True

False

Then

ToolbarPlayButton .Enabled = True

ToolBarStopButton .Enabled = False

End If

End Sub

(ii) Setting Device Properties

' Show the device selection dialog.

Private Sub SelectDevice()

If IcImagingControll.LiveVideoRunning Then
IcImagingControll.LiveStop()
IcImagingControll.ShowDeviceSettingsDialogO

If IcImagingControll.DeviceValid Then
IcImagingControll.LiveStart()

End If

Else

IcImagingControll.ShowDeviceSettingsDialog()
End If

UpdateControls()

SetWindowSizeToImagesize 0
SaveSelectedDevice(IcImagingControll)

End Sub

ShowProperties

Show the property dialog of the current video capture device.

Private Sub ShowProperties()
If IcImagingControll.DeviceValid Then

IcImagingControll.ShowPropertyDialogf)
UpdateControls()

End If

End Sub
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(iii) Capturing and saving image

Private Sub Savelmage0
If IcImagingControll.DeviceValid Then

' Snap (capture) an image to the memory

IcImagingControll.MemorySnapImage()

' Call the save file dialog to enter the file name of the

image

Dim saveFileDialogl As New SaveFileDialog
saveFileDialogl.Filter = "bmp files (*.bmp)|*.bmp|All

files (*.*) j*.*"

saveFileDialogl.Filterlndex = 1

saveFileDialogl.RestoreDirectory = True

If saveFileDialogl.ShowDialogO = DialogResult.OK Then
' Save the image.

IcImagingControll.MemorySavelmage(saveFileDialogl.FileName)
PictureBoxl.Image = newImg.FromFile{saveFileDialogl.FileName)
refPath = saveFileDialogl.FileName

Processlmage(refPath, saveFileDialogl.FileName)
End If

End If

End Sub

(iv) Image Processing: Identifying the available parking space in parking area

(MATLAB)

function park = imgDiff(Ref_gray,Cur_gray)

img_diff - imabsdiff(Ref_gray,Cur_gray);
total_diff = sum(sum(img_diff));
Avg_Img_diff = total_diff/(10*10);

if Avg_lmg_diff <= 15
park = 'vacant*;
%status = 0;

else

park = 'occupied';

%status = 1;

end
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(v) Image Processing: Displaying the status of each parking space.

Ref_gray = imcrop ( picRef_gray / [47 33 10 10]
Al_gray = imcrop ( picCur_gray , [47 33 10 10])
park - imgDiff(Ref_gray,Al_gray);
Al - strcat( 'Al :', park)

Ref_gray = imcrop ( picRef_gr.ay , [90 33 10 10]
A2_gray = imcrop ( picCur_gray , [90 33 10 10])
park = imgDiff(Ref_gray,A2_gray);
A2 = strcatf 'A2 :', park)

(vi) Saving AVI Video

Private Sub ShowAVIDialog0
If IcImagingControll.DeviceValid Then

Dim AVlDlg As AviDialog = New

AviDialog(IcImagingControll)
AVIDlg.ShowDialogO

AVIDlg.Dispose()
AVlDlg = Nothing

End If

End Sub

' Start the AVI capturing.

Private Sub cmdStartButton_Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles cmdStartButton.Click

If ImagingControl.DeviceValid Then

ImagingControl.AviStartCapture(edtAVIFile.Text,

CodecBox.Selectedltem)

cmdStartButton.Enabled = False

cmdStopButton.Enabled = True

End If

End Sub

' Stop the AVI capturing.
i

Private Sub cmdStopButton_Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles cmdStopButton.Click

If ImagingControl.DeviceValid Then
ImagingControl.AviStopCapture()
cmdStartButton.Enabled = True

cmdStopButton.Enabled = False

End If

End Sub
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4.1.5 System Input and Output

(i) Example of images as system input

Figure 4.7 Example of system input

(ii) System output on Bluetooth enabled devices

This is the expected output should be displayed on the user's Bluetooth enabled

devices,which contains imageofparkingarea and the information ofeach parking

lot location (Right: Figure 4.8). However, currently this system is able to display

imagesto user's Bluetoothenableddevices,withoutthe information ofthe parking

space. The hand phone being used for this project is Nokia 6111 (Left: Figure4.8).
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Figure 4.8 System output on Bluetooth enabled device

(ii) Example of data after image processing from Matlab

Ffe Edit Wew Insert Tods Desktop Window

MATLAB Command Window

To get started, tppe one of these: he]
For product infornation, visit urn.oat

a ingProcess('enpty.D«p*,*test2.6ap')

A1 =

A1 :occupied

A2 =

A2 :uacant

A3 =

A3 :vacant

A4 =

A4 :uacant

AS -

A5 :uacant

A6 =

A6 :occupied

Figure 4.9 Example ofImage Processing output.
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(iii) System Constraint

Systems constrain that need to be considered is:

• The position of the camera needs to be static in particular location, where it can

view the whole parking area. If the position of the camera is moved to the left or

to the right (as shown in Figure 4.10), from the initial setup position, the image

of the parking area still would be captured but the information about the

available parking spaces would be inaccurate.

Figure 4.10 Example of system input from a moved camera

4.2 Discussion

4.2.1 Integrating MATLAB and VB.NET

The integration between matlab and visual basic is done by calling a COM object

and .dlL, which are created by MATLAB, from Visual Basic. The Processlmage

function (VB.Net) calls the imgProcessing function (Matlab) and run the m-flle.

Each of the output is saved into the database. The integration is automated without

opening the workspace window. The system captures and saves the images in a

particular folder. Then, the latest image is grabbed and processed (by calling the m-

file function in matlab) automatically. The image and available location can be

viewed by administrator. (Figure 4.11)
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4.2.2 Data extraction

The information of available parking space and numbers of available parking space

is extract from MATLAB function to Microsoft Excel (as database). This

information then is shall be viewed by administrator as well as Bluetooth-enabled

mobile user (drivers). The information includes image name, row and column of

each parking space.

Private Sub Processlmage(ByVal refPath As String, ByVal curling
As String)

Dim imgFile As String
Dim p As Processing.processImgClass
p = New Processing.processImgClass

Try

p.imgProcessing (refPath, curling)
imgFile = curlmg & ".txt"

Dim fReader As StreamReader = New StreamReader(imgFile]

rchLocation.Text = fReader.ReadToEnd

fReader.CloseO

fReader = Nothing

Catch ex As System.Exception
MsgBox(Err.Description)

End Try
End Sub

Figure 4.11 Processlmage function - calling m-file function from VB.Net

4.2.3 Help Function

This system also provides Help function as a guide for end-user. The Help function

provides user manual and detail explanation on every menu items, buttons, and

functions of each toolbar, as well as the interface of every window in the system.

The Help function focus on guiding user especially novice user, to ease their

navigation on the system and provide a user-friendly system. User can click on the

Help -> User Guide menu item to viewthis window(Figure4.12) or press Fl.
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Hide Pratt Options

Contents ijjdex | Search!
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[?J Introduction
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[?I Tutorial

H (121 Dialogs
+!^ AboutV-PSLS

SaveAVIFile

.+!
?3 Support
?] Copyright

Vehicle Parking Space Locate

:>i

Figure 4.12 Help function

Vehicle Parking
Space Locator
Svstem

t_B Vehicle Parking Space Locator System

Hie Review Device Settings Help
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CHAPTERS

CONCLUSION AND RECOMMENDATION

5.1 Conclusion

This report describes the overview of the Vehicle Parking Space Locator for

Surveillance system development. The system is utilizing the Bluetooth wireless

technology with mobile phone. The development of this system has to successfully

resolve the problems derived from the finding of parking space in parking area and

providereliable and accessible systemfor all mobile users. This report also explains

the appropriate methodology to be used in developing the system, which is Rapid

Application Development (RAD). The system hardware and software requirements

and specifications to be used also mentionedbriefly. The system application is aim

at giving mobile clients maximum facilities of the mobile phones and

comfortableness in searching parking space.

This system is expected to benefits mobile users and drivers, as well as

parking area providers with some enhancements on certain area of the system. The

results show that by utilizing Bluetooth technology, the system provides low service

cost and expects to meet user needs. This project shows the capability of developing

new idea and technology to improve on existing applications for better human

lifestyle. In addition, I believe I have gained both practically and academically in

acquiring management and communication skill throughout the project

development. This project is quite challenging since it require the developer to have

sufficient knowledge of all the application being used in order to come out with

excellent results. There are a lot to be improved on the system especially on the

database part and integrating with other Bluetooth applications, which may require a

lot ofmemory spaces to make sure the system functions smoothly.
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5.2 Recommendation

Suggested future work for expansion and continuation:

(i) Provide more security measure with surveillance

Currently, the system only provides monitoring service, which administrator can

monitorthe parkingarea and vehicles activities, enter and exit the parking area only.

It would be better if the system can detect and identify the vehicle that enter and exit

the parking area and trigger an alarm if there are different activities or suspicious

activities going on. For instance, if there's someone or unauthorized person, who

suddenlychangethe positionof the camera, an alarm is triggered.

The system also should supporterror detection codes to detect incorrectuser

input and output. For example, if the system can not process the image correctly, a

pop up message would appear to inform the administrator "The image is invalid"

instead ofdisplayingthe incorrect location information.

The systemalso may providebackup data for the images and data. However,

this may require a big system storage and memory space.

(ii) Can detect if the parking area is resized

The system should also be able to detect if the parking area size has been resize, and

be able to grab the correct number of parking lot after it has been resize and produce

the correct output. For example, if the number of parking lot is added from 12 to 18,

the system shouldbe able to detect that the current parking lot is 18, and process 18

parkinglot instead ofjust 12, providing the cameraalso has been resize accordingly.

(iii) Computer storage and memory space
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It would be better if the developer/administrator could have better data storage so

that all the images can be kept for specific time (3 or 4 months) for reference. Larger

memory space (RAM) also needed to ensure the system can run smoothly without

hang or rebooting, since image processing using Matlab and the integration made

requires a lot ofmemory spaces.

(iv) 'Refresh' function and more user friendly system.

The system also should provide 'Refresh' button so that user can always return to

clear state/previous state if inappropriate condition happens on the system. The

system should also provide more option for administrator to view the previous saved

image or saved video file from the system interface while monitoring the parking

area. Admin do not have to minimize the system window and go the folder and

search for the image manually.

Easy navigation from one link to another is required especially for beginner users. It

would be better if next future enhancement have more user-friendly interface that

provide user with easy navigation. Currently, the system provides Help function to

guide user to setting up the device and previewing methods.

(v) Gives more option for user/drivers to get information about parking space.

Current system focus on helping drivers who are on the way to the parking area, that

need information about empty parking space in a particular parking area. This

system only applicable if the user have Bluetooth-enabled devices/mobile phone.

For future enhancement, the system may have two options, which are Bluetooth

technology and web-based application for other people outside the Bluetooth system

range. For instance, a driver A, who do not have Bluetooth-enable device, wants to

park his/her car to Parking ABC (that has parking system), then if he/she can call

his/her friend from outside to look for available parking space on the

internet/website.
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(vi) Detect and display the expected output on real user's Bluetooth enabled

devices

The system should be able to detect when a user connects with the system using

their Bluetooth mobile phone, and the system should be able to send the image of

the current parking area WITH the location information automatically (as shown in

Figure 4.8). Currently, the system is able to send the current image of parking area

to user's Bluetooth mobile phone but WITHOUT the location information, and it is

done manually (administrator get the current image and send it to user)
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Gantt Chart for Final Year Project Part 1

Final Year Project Part 1
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Gantt Chart for Final Year Project Part 2

Final Year Project Part 2

Project Task/Output w1 w2 w3 w4 w5 w6 w7 w8 W9 w10 W11 w12 w13 w14
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